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Introduction

Cisco Configuration Assistant (CCA), part of the Cisco Smart Business
Communications System (SBCS) portfolio of products, simplifies the tasks of
configuring, deploying, and administering Cisco network solutions, improves the
security and performance of your network, and reduces the time needed for
network deployment and configuration. Designed for small business networks
from 8 to more than 100 users, this PC-based application with a Graphical User
Interface (GUI) provides everything you need to set up a small office network.

New Features in CCA 3.2

CCA 3.2 is a major software release that contains significant features and user
interface changes.

In addition to the changes listed below, see “Limitations and Restrictions,
page 18” for important information that applies to CCA release 3.2.

Feature Description.

Voice Feature Configuration

Generic SIP Allows new service providers to be added in CCA
Trunking without the requirement to import XML template.

Allows modification of service providers, including
options for voice codec, fax protocol, registration, DTMF,
call transfers, and call forwards.

Disable Call- Audible rings are suppressed for incoming calls, but call-
waiting Beep waiting beeps are allowed during active calls. Visible
cues are the same as those described for a normal ring.

Feature Ring Differentiates incoming calls, on a special ling, from
incoming calls on other lines of the phone. The featuring
cadence is a triple pulse; as opposed to a single pulse for
normal internal calls, and a double pulse for normal
external calls.
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Feature

Description.

Silent Ring and
Feature Ring
button mapping

Audible ring and call-waiting beep are suppressed for
incoming calls. The only visible cue is a flashing icon in
the phone display.

Time management
for SIP Trunks

Allows configurations of timers and retries for the SIP
user agent.

Support
Distinctive Ring
pattern for
incoming call

Distinctive ring is used to identify internal and external
incoming calls. An internal call is defined as a call origi-
nating from any Cisco Unified IP phone that is registered
in Cisco Unified CME or is routed through the local FXS
port.

Support unknown
plan type for
International calls
for ISDN carrier

Allows to map all outgoing calls to unknown numbering
type and plan.

Ability to apply
Service URLs
under Telephony
Service

Allows configuring URL information under telephony
service. Specific URLs are provisioned on the Cisco IP
phone; these URLs point to XML-based web pages
formatted with XML tags that the Cisco IP phone
understands and uses.

SSL VPN Configurati

ion

Provide an option
to enter SSL VPN
Port

Provides the option to configure SSL VPN port during
SSL creation on UC500.

Ability to accept
the DHCP
assigned IP
address on the
WAN for SSL VPN

Allows creation of SSL VPN using DHCP WAN IP and also
warns the user of any changes to the WAN IP that will
cause SSL VPN to not work.

Multisite Configuration

Site-to-Site VPN
Only and Site-to-
Site Dialing only

Allows users of CCA multisite to have Site-to-Site dialing
only, or Site-to-Site VPN only, or both.

Security
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Feature Description.

ACL Management/ | Allows new ACLs to be added to the list of already

Editing existing ACLs generated by the CCA. ACLs used by
CCA are not editable.

Ability to backup current ACL configuration.

Ability to restore a backed-up ACL configuration.

System Requirements

The system requirements are described in these sections:
Installation Requirements, page 4

Managed Device Support, page 7

Installation Requirements

The PC on which you install Cisco Configuration Assistant must meet these
minimum requirements.

NOTE System requirements for processor, memory, display resolution, and disk
space have been increased.
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System Requirements

Operating
Systems
Supported
(Windows)

Microsoft Windows Vista® Ultimate (32-bit or 64-bit
edition).

Microsoft Windows XP® Professional, Service Pack 2 or
later.

Microsoft Windows 7® (64-bit and 32-bit).

You must have write permission to your home directory and
to the CCA installation directory; so that CCA can create
the necessary log files and preference files.

For PCs running Windows Vista and Windows 7,
Administrator privileges are required in order to update,
install, and use CCA.

NOTE When using CCA on PCs running Microsoft
Windows 7, set the auto sleep function to Never. To change
the PC’s setting follow these steps:

Go to Control Panel > Power Options.
By default, it is set to Balanced.

Click Change when computer sleeps

Increase “Put computer to sleep” from 5 minutes
(default) to Never

Mac OS Support
(requires
virtualization
software)

Mac OS: 10.5 and later

Virtual OS: Parallels Desktop 3.1 and later or VMware
Fusion 1.0 and later

Guest OS: Microsoft Windows XP (Service Pack 2 or later),
Microsoft Windows Vista Ultimate. CCA also supports
remote control via Virtual Network Computing (VNC)
clients.

Hardware

PC with FastEthernet or higher LAN port

Processor

1.8 GHz Intel Core 2 Duo or higher

Disk Space

400 MB recommended
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System Requirements

Memory At least 2 GB for Windows 7, Windows XP, and Windows
Vista.

Display Screen resolution: 1280 x 1024 or higher recommended

Browser Microsoft Internet Explorer 8.0 or later is recommended,

with Javascript enabled.

The Adobe® Flash® Player 10 or later plug-in for Microsoft
Internet Explorer must also be installed (in addition to any
other version of the Flash plug-in that you may have
installed for different Web browsers).

Javascript must be enabled for the Microsoft Internet
Explorer browser.
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Managed Device Support

CCA manages the following phones, switches, routers, access points, wireless
LAN controllers, and IP video cameras.

Table1 Managed Device Support

Device Type Models

Cisco UC500 | UC520 Platform
Series

Platform UC520-8U-4FX0O-K9

UC520W-8U-4FX0O-K9
UC520-8U-2BRI-K9
UC520W-8U-2BRI-K9
UC520-16U-4FX0O-K9
UC520W-16U-4FX0O-K9
UC520-16U-2BRI-K9
UC520W-16U-2BRI-K9
UC520-24U-8FX0O-K9
UC520-24U-4BRI-K9
UC520-32U-8FX0-K9
UC520-32U-4BRI-K9
UC520-48U-12FX0O-K9
UC520-48U-6BRI-K9
UC520-48U-T/E/F-K9
UC520-48U-T/E/B-K9

UC540 Series Platform

UC540W-FXO-K9
UC540W-BRI-K9

UC560 Series Platform

UC560-FXO-K9
UC560-BRI-K9
UC560-T1E1-K9
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Table1 Managed Device Support

Device Type Models

Modules and VIC-4FXS/DID

Interface VIC2-2BRI-NT/TE

Cards VIC2-2FXO
VIC2-4FXO
VIC2-FXS

VIC3-2FXS/DID
VIC3-4FXS/DID
VWIC2-1MFT-T1/E1
VWIC2-2MFT-T1/E12
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Table1 Managed Device Support

Device Type

Models

Phones

Cisco Model 6900 Series IP phones:

6961
6941
6921
6911 (NOTE: Video unsupported)
6901 (NOTE: Video unsupported)

NOTE Model 6945 is not supported.
Cisco Unified IP Phones 7900 Series, all models:

7940G
7960G
7975G
7971G-GE
7970G
7965G
7962G
7961G
7961G-GE
7945G
7942G
7941G
7941G-GE
7937G
7931G
7911G

Cisco SPA 500 Series IP Phones, all models:

SPA525G2 5-Line
SPA525G 5-Line

SPA509G 12-Line
SPA508G 8-Line

SPA504G 4-Line

SPA502G 1-Line

SPA501G Basic 8-Line
SPA500S Expansion Module
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Table1 Managed Device Support

Device Type Models

Phones Cisco SPA 300 Series IP Phones, all models:
(continued)

SPA301

SPA303

Cisco CP-521/524 phones

Cisco IP Communicator

Switches Catalyst Express 520 switches, all models
Cisco ESW500 Series switches, all models

ESW-520-8P 8-Port FastEthernet Switch with PoE
ESW-540-8P 8-Port Gigabit Ethernet Switch with PoE

ESW 520-24, 24-Port 10/100, non-PoE
ESW 520-24P, 24-Port 10/100, PoE
ESW 520-48, 48-Port 10/100, non-PoE
ESW 520-48P, 48-Port 10/100, PoE

ESW 540-24, 24-Port 10/100/1000, non-PoE
ESW 540-24P, 24-Port 10/100/1000, PoE
ESW-540-48, 48-Port 10/100/1000, non-PoE

SF 300 Series models
SG 300 Series models
SF 200 Series models
SG 200 Series models

NOTE: SG200-08 and SG200-08P switches are not
supported.
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Table1 Managed Device Support

Device Type

Models

Routers

Cisco Unified Communications 500 Series platform, all models

Cisco SA500 Series Security Appliances, all models (SA520,
SA520W, and SA540)

Cisco SR500 Series Secure Routers
Model SR520-ADSL, - Ethernet
Model SR520-T1

Cisco Services Ready Platform SRP500 Series, all models,
discovery and cross-launch of native Web-based
Configuration Utility only.

Cisco 800 Series Routers: Models 831, 836, 851, 851W, 857,
857W,871,871W, 876, 876W, 877,877M,877W, 878, and
878W

Access
Points

Cisco Small Business Pro AP54 1N Dual-band Single-radio
Access Points

Cisco 521 Wireless Express Controller-Based Access Points

Cisco 521 Wireless Express Autonomous Access Points

Wireless LAN
Controllers

Cisco 526 Wireless Express Mobility Controllers

Video
Cameras

Cisco Model WVC2300 and PVC2300 Business Internet Video
Cameras

Downloading and Installing Cisco Configuration Assistant

To install CCA on your PC, follow these steps:

STEP 1 Go to www.cisco.com/go/configassist. You must be a registered Cisco.com user,
but you need no other access privileges.

STEP 2 In the Support information box, click the Download Software link.
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STEP 3

STEP 4

STEP 5

STEP 6

If you are not already logged in, you are redirected to the Cisco.com log in page.
Enter your Cisco.com username and password to log in.

Locate the CCA installer file, for example:
cisco-config-assistant-win-k9-3 2-en.exe

Download the CCA installer and run it. You can run the installer directly from the
web if your browser offers this choice. CCA is free; there is no charge to
download, install, or use it.

When you run the installer, follow the on-screen instructions. On the final page click
Finish to complete the installation.

Available and Deferred CCA Versions

The following CCA releases are available for download from Cisco.com:
CCA 3.2
CCA 3.1

All other versions of CCA are deferred and are no longer available on Cisco.com.

Updating Cisco Configuration Assistant

STEP 1

STEP 2

STEP 3

STEP 4

Cisco strongly recommends that you upgrade your CCA to the latest version in
order to take advantage of new features and resolved issues.

You can use the automated Application Updates feature to update Cisco
Configuration Assistant to a later release in the language that you are using. Follow
these steps:

Start Cisco Configuration Assistant.
Choose System > Application Updates.

In the Authentication window, enter your Cisco.com username and password and
click OK.

In the Application Updates window, click Yes.

12
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NOTE Cisco Configuration Assistant 2.x installations cannot be updated to
version 3.0 and later using the Application Update process. You must download
Cisco Configuration Assistant from Cisco.com (www.cisco.com/go/configassist)
and install it manually.

Cisco UC500 Software Packs

Cisco UC500 Software Packs are large zip files that contain all necessary files for
the Cisco UC500 Series platform. Each zip file contains multiple TAR/archive files
for the components of the UC500, including:

I0S image for the UC500 platform

IP Phone firmware files

Voice mail software

Factory default configurations for each SKU

Support files, such as Basic ACD prompts and scripts, ringtones, and
desktop images

Separate UC500 software package files are provided for the Model UC520,
UC540, and UC560 platforms. You must download the correct .zip file for your
UC500 platform (UC520_8.2.0.zip, UC540_8.2.0.zip, or UC560_8.2.0.zip).

Cisco UC500 Locale Packs

UC500 Locale Packs contain the software needed to localize voicemail and
phones (locales for Cisco Model 79xx, SPA525, SPA50x, and CP-52x phones).

This means that you only need to download one file to localize voice mail and all
supported phone models.

A locale pack can be provided when installing software on the UC500 via CCA in
order to install an alternate language on the UC500. Up to two languages can be
installed, an active language and an alternate language.

UC500_8.2.0_locale_da_DK.zip (Danish)
UC500_8.2.0_locale_de_DE.zip (German)
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UC500_8.2.0_locale_en_GB.zip (UK English)
UC500_8.2.0_locale_en_US.zip (US English)
UC500_8.2.0_locale_es_ES.zip (European Spanish)
UC500_8.2.0_locale_es_MX.zip (Mexican Spanish)
UC500_8.2.0_locale_fr_FR.zip (European French)
UC500_8.2.0_locale_fr_CA.zip (Canadian French)
UC500_8.2.0_locale_it_IT.zip (Italian)
UC500_8.2.0_locale_nl_NL.zip (Dutch)
UC500_8.2.0_locale_no_NO.zip (Norwegian)
UC500_8.2.0_locale_pt_PT.zip (Portuguese)
UC500_8.2.0_locale_sv_SE.zip (Swedish)

Downloading Cisco UC500 Software and Locale Packs

To download Cisco UC500 Software Packs, go to the following URL:
www.cisco.com/go/uc500swpk

IP phone localization files and voice mail localization files are also available from
this URL. A Cisco.com login is required.

Available Software Packs

These UC500 software packs are available for download:
Table 2, “Cisco UC520 Software Packages,” on page 15
Table 3, “Cisco UC540 Software Packages,” on page 15

Table 4, “Cisco UC560 Software Packages,” on page 15
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Table 2 Cisco UC520 Software Packages

UC520 Software Filename CCA Version Component/Version Information
Pack Version Compatibility
8.2.0 for UC520 UC520_8.2.0.zip (US/English) CCA 3.1 and later Cisco IOS 15.1(2) T4

CUCME 8.1

CUE 8.0.6

B-ACD scripts v4

UC520 factory default configurations
8.1.0 for UC520 UC520_8.1.0.zip (US/English) CCA 3.0 and later Cisco IOS 15.1(2) T2

CUCME 8.1

CUE 8.0.3

B-ACD scripts v3.0.0.2

UC520 factory default configurations

Table 3 Cisco UC540 Software Packages

UC 540 Software
Pack Version

Filename

CCA Version
Compatibility

Component/Version Information

8.2.0 for UC540

UC540_8.2.0.zip (US/English)

CCA 3.1 and later

Cisco I0S 15.1(2) T4

CUCME 8.1

CUE 8.0.6

B-ACD scripts v4

UC5240 factory default configurations

8.1.0 for UC540

UC540_8.1.0.zip (US/English)

CCA 3.0 and later

Cisco I0S 15.1(2) T2

CUCME 8.1

CUE 8.0.3

B-ACD scripts v3.0.0.2

UC540 factory default configurations

Table 4 Cisco UC560 Software Packages

UC 560 Software
Pack Version

Filename

CCA Version
Compatibility

Component/Version Information

8.2.0 for UC560

UC560_8.2.0.zip (US/English)

CCA 3.1 and later

Cisco I0S 15.1(2) T4

CUCME 8.1

CUE 8.0.6

B-ACD scripts v4

UC560 factory default configurations

Release Notes for Cisco Configuration Assistant 3.2
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Table 4 Cisco UC560 Software Packages

UC 560 Software Filename CCA Version Component/Version Information
Pack Version Compatibility
8.1.0 for UC560 UC560_8.1.0.zip (US/English) CCA 3.0 and later Cisco I0S 15.1(2) T2

CUCME 8.1

CUE 8.0.3

B-ACD scripts v3.0.0.2

UC560 factory default configurations

IP Phone Firmware Loads

Table 5 lists the firmware releases required for the IP Phones that Cisco
Configuration Assistant manages. This table lists phone firmware loads that are
included with the UC500 software packs and have been validated for use with
CCA. If instructed to install a later version of phone firmware to resolve a support
issue, use the CCA Phone Load Management window or drag-and-drop phone
upgrade feature to install the phone firmware.

This most recent list of phone firmware loads is located at:
https://supportforums.cisco.com/docs/DOC-9827

Table 5 Cisco IP Phone Firmware Loads

6921
sore | sprsaso | Soa0c | agg | 786 |7 | sens | 00y | 7980 | e | 907 | o
8.2.0 74.8 7.4.8a 5.0.4 1.0.4 1.3.4SR1 3.3.20 1.3.4 812 8.5.4S 9.0.2 8.5.4
8.1.0 74.6 74.6 5.0.4 1.0.4 1.3.4SR1 3.3.20 1.3.4 812 8.5.4S 9.0.2 8.5.4
8.05 74.4 74.4 5.04 104 1.3.4SR1 3.3.20 134 8.1.2 8.5.3S -- --
8.04 74.4 74.4 5.04 104 1.3.4SR1 3.3.20 134 8.1.2 8.5.3S - -
8.0.3 74.4 74.4 5.0.4 1.0.4 133 3.3.20 1.3.4 8.12 8.5.3S - -
8.0.2 74.3 74.3 5.04 104 13.3 3.3.20 134 8.1.2 8.5.3S -- --
8.0.1 74.3 74.3 5.0.4 1.0.4 133 3.3.20 1.3.4 8.12 8.5.3S - -
8.0.0 74.2 74.2 5.0.4 1.0.4 133 3.3.20 1.3.4 8.12 8.5.3S - -
70.4 71.9 71.3c 5.0.3 103 121/ 1.341 3.3.16 13.2 8.01 8.4.2S -- --
713 719 71.3c 5.0.3 1.0.3 121/ 1341 3.3.16 1.3.2 8.0.1 8.4.2S - -
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Upgrading the UC500 and Installing Device Software

To upgrade software on the UC500 and other devices using CCA, choose

Maintenance > Software Upgrade.

For instructions on how to upgrade software on Cisco UC500 Series platforms,
see the CCA online help or the Cisco Configuration Assistant (CCA) Smart
Business Communications System Administrator Guide, available on Cisco.com.

Minimum Cisco I10S Releases and Device Firmware Versions

Table 6 lists the minimum software releases required for the devices that Cisco

Configuration Assistant manages.

Table 6 Minimum Cisco IOS Release or Firmware Required

Device

Minimum Software Release

Cisco Unified Communications 500 Series
Model UC520

12.4(20)T2 or 12.4(22)YB

Cisco Unified Communications 500 Series
Model UC540

12.4(24)SB

Cisco Unified Communications 500 Series
Model UC560

Cisco 10S 15.0(1) XA

Catalyst Express 500 switch

Cisco 10S 12.2(15)T9

Cisco Catalyst Express 520-8PC switch

Cisco 10S 12.2(35)EX

Cisco Catalyst Express 520-24PC switch 12.2(37)EX
Cisco Catalyst Express 520-24LC switch

Cisco Catalyst Express 520-24TT switch

Cisco Catalyst Express 520G-24TC switch

Cisco 800 Series router 12.4(4)T
Cisco 526 Wireless Express Mobility 42.61.4
Controller

Cisco 521 Wireless Express Access Point 12.4(10b)JX

Release Notes for Cisco Configuration Assistant 3.2
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Table 6 Minimum Cisco IOS Release or Firmware Required

Device Minimum Software Release

Cisco Small Business Pro AP54 1N Firmware version 1.8.0
Dual-band, Single-radio Access Point

Cisco SR520 Secure Router 12.4(20)T4 and later
(ADSL or Ethernet)
Cisco SR520-T1 Secure Router SR520-T1 Software Pack

Cisco SAS500 Series Security Appliances, Software Version 1.1.65 or later

all models (SA520, SA520W, and SA540). )
IMPORTANT Cisco SA500

Series software versions 1.1.42
and earlier are not supported for
use with CCA.

Use the SA500 Security
Appliance Configuration Utility to
manage the SA500 or upgrade to
version 1.1.65 or later of the
SA500 software.

Cisco Small Business Pro ESW500 Series ESW500 Series 24 - and 48-port
Switches models: Firmware version 2.0.3

ESW500 Series 8-port PoE
models: Firmware version 2.1.1 or
later.

Limitations and Restrictions

These limitations and restrictions apply:

After a CME reload, the MWI indicator is turned OFF for phones that have
new messages. This is due to an issue in the CUE software. The new
messages are still there, but since the MWI indicator is not lit, users may not
know about them. To correct the problem, launch CCA, open the Topology
view, right-click on the UC500 icon, and choose the MWI Refresh All option.

When performing drag-and-drop firmware upgrades for Cisco IP phones
using loads downloaded from Cisco.com, you must use the correct type of
file (.bin, .tar, or .zip file, depending on the phone model):
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- Cisco 7900 Series IP phones — Use the .zip file, except for Model 7921
and 7925, which require you to use the .tar file.

- Cisco 6900 Series IP phones — Use the .zip file.
- SPA525 IP Phones — Use the .bin file.

- SPA 5x5 IP phones (Models 501, 502, 504, 508, and 509) — Use the .bin
file.

The following known issues with Cisco I0S Version 15.1(2)T2 may be
encountered. Cisco I0S 15.1(2)T2 is included with UC500 software pack
Version 8.1.0.

- After a firmware upgrade, softkeys on the home page of the SPA525 IP
phone are blank. To work around this issue, reboot the phone.

- NULL pointer exception not caught in PPC platforms.

When connecting a 7937 phone to a UC500 it comes up ok, but after adding
the user information via CCA Ul the phone may go into an endless reset
loop. Sometimes it comes up after 24 hours, other times it does not.

As a possible workaround, please download the latest firmware version
from Cisco Download Site <http://www.cisco.com/cgi-bin/tablebuild.pl/ip-
7900ser-crypto>. To update the firmware on the 7937 phone, please use
the drag and drop feature in CCA to drag and drop the latest 7937 firmware
load onto the UC500 image located in the Topology View.

When using CCA on PCs running Microsoft Windows 7, file selection dialogs
are missing icons for buttons on the upper right corner of the dialog (for
example, the Up one Level button icon). This problem occurs due to a
known issue in the Java Runtime Environment (JRE) library. The JRE library
cannot retrieve the related icon resource from the native Windows 7
platform to render certain file chooser widget buttons.

The issue is cosmetic and does not affect functionality. The user can still
browse the entire file system and select a target directory or file.

Although the buttons are not visible, the user can position the mouse over
the button to view its Tooltip text to identify the purpose of the button. The
button works as expected when the user clicks on it.

Some Cisco Model 79xx IP phones cannot be directly upgraded from 8.3.3
or earlier to 8.5.3 or higher. You may encounter this issue when upgrading

phone loads or when upgrading to a new UC500 software pack. When the
issue occurs, Cisco Model 79xx phones may fail to register. For instructions
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on how to resolve the issue, see Resolving Cisco Model 79xx Phone
Upgrade Issues, page 25.

CIPC (Cisco IP Communicator) phones configured for Whisper Intercom
requires software version CIPC 7x or later.

Cisco SA500 software versions 1.1.42 and earlier are not supported for use
with CCA. If the SA500 is running software version 1.1.42 or earlier, it cannot
be added to a CCA customer site and cannot be managed using CCA.

Use the SA500 Security Appliance Configuration Utility on the device to
configure the SA500 if software version 1.1.42 or earlier is installed.

Drag-and-drop file operations from the PC running CCA onto device iconsiin
the Topology view may fail due to Windows Vista or Windows 7 User
Account Control (UAC) restrictions. A “No Entry” icon is displayed.

To work around this limitation, temporarily disable the User Account Control
(UAC) in Windows Vista, perform the operations and then re-enable the UAC.

Some of the drag-and-drop file operations that CCA supports include:
- SR520-T1 firmware upgrade file

- 10S image files

- IP phone loads (not all models support drag and drop upgrade)

- CP-500 language files

- Music on Hold audio (.au) files

- Cisco Unity CME language files for localization

- UC500 factory default configuration file

- System speed dial .xml file

CCA does not support upgrade of boot code (.rfb files) on ESW500 Series
switches, only firmware (.ros files). Use the ESW500 Configuration Utility to
upgrade the boot code if needed.

Since ESW500 Series firmware version 2.1.16 requires boot version 1.0.0.7
for 8-port ESW models, and boot version 1.0.0.4 for 24-port and 48-port
models, you may need to manually install or upgrade the boot code to
ensure that the appropriate versions are used.
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First upgrade the boot code, then the firmware, change the active image,
save the configuration, then reboot the ESW switch. In the ESW500 Series
Configuration Utility, software upgrade options for ESW switches are
located under Maintenance > File Management.

To download firmware and boot code files for ESW switches, go to
www.cisco.com/go/esw500help, click the Resources tab, then click the
Firmware link. A Cisco.com login is required.

The following limitations apply to video monitoring on SPA525G phones:

- While monitoring video from the SPA525G phone, the phone can still
make and receive calls. However, inbound calls do not change the display
focus, and the only visual indication will be a flashing LED associated with
the line being called. To answer inbound calls, simply press the line
button.

- If you are viewing video on the phone, the video application stops when
you make an outbound call and does not automatically resume.

- There is no audio integration between the IP phone and the cameras.

- Door Access Control from the SPA525G phone, using the GPIO ports on
the back of the camera, is not supported.

- The MJPEG settings for the cameras cannot be changed if the camera is
integrated with the SPA525G phone. Changing these settings will
prevent the video stream from being displayed on the phone. These are
the video settings that must be configured using the PVC2300/
WVC2300 Configuration Utility:

Resolution: 320240
Max Frame Rate: 10 fps
Fixed Quality: Normal

In mixed networks that have both AP54 1N and AP521 wireless access

points, the CCA 2.2(2) Wireless Setup Wizard automatically synchronizes
AP54 1N settings only. In this case, existing AP521 access points must be
synchronized from the Configure > Wireless > WLANs (SSIDs) window.

CCA 2.2(2) and later can discover a Services Ready Platform SRP500 device
and display its icon in the Topology view; however, in order to be discovered,
the SRP500 device must be connected to a UC500 or a port on an ESW500
Series switch that is connected to a UC500. You must use the UC500 or
ESW500 IP address as the starting IP address for discovering the SRP500.
You cannot use the IP address of the SRP500 to discover the device or
network.
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The Cisco VPN Client does not provide 64-bit support. However, 64-bit
support is available for the Cisco AnyConnect VPN Client. This client and
release notes can be obtained from the Software Center (www.cisco.com/
go/software). If you do not have a valid service contract associated with your
Cisco.com profile you cannot log in and download the AnyConnect VPN
Client. The AnyConnect client supports SSL and DTLS. It does not support
IPSec at this time.

For more information, see the release notes for the Cisco VPN Client and
Cisco AnyConnect client.

Remote SSL VPN phones (for example, SPA525G phones with remote VPN
configured through the CCA VPN Phone Setup Wizard) are not displayed in
the Topology view.

Bonjour devices do not show connectivity in Topology view on discovery.

For full-tunnel mode with SSL-VPN server on UC500 and SR500 platforms,
only the Anyconnect-win-2.3.2016-k9.pkg for Windows 32-bit or 64-bit OS
is supported.

If the PC running Cisco Configuration Assistant is not directly connected to
the UC500 LAN (through a wired connection or VPN connection), the
Multisite Manager is not available. When managing a multisite deployment,
care should be taken not to invoke or configure features such as software
upgrade, backup and restore, internet connection, or restart/reset on
remote sites.

For Cisco SR500 Series Secure Routers (all models), you cannot install an
IPS (Intrusion Prevention System) Signature Data File (SDF) package with a
version that is greater than 384. This is due to file size constraints on SR500
devices.

As a workaround, install the SDF package version 384, then upgrade to a
later version.

- When choosing an SDF package to install, select version 384 of the SDF
package, which is sigv5-SDM-S384.

- After the SDF package is installed, choose Configure > Security > IPS
and select the IPS Signature Update tab to perform the update.
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The following limitations apply to the WebEx PhoneConnect application:

- In order for WebEx PhoneConnect to function properly, password
changes must be disabled on the WebEXx service site. The WebEXx site
administrator must un-check the Allow user to change password option
on the service site to disable it, even if Auto-Login APIs are being used.

- Once a phone has received two consecutive, unacknowledged meeting
alerts, audio (tone) alerts are suspended until the phone user presses the
Snooze, Dismiss, or Call softkey. This can occur when multiple
unanswered alerts are received for the same meeting or for multiple
meetings scheduled for the same time.

The following limitation applies to the WebEx Connect client and may affect
Cisco WebEx PhoneConnect users who are also using the click-to-dial
feature.

- The WebEx Connect client Click-to-Dial feature does not work if you do
not run as Administrator in Microsoft Windows Vista.

On a PC running the Microsoft Vista operating system, if you login with a
username that has administrator privileges but does not have the
username of Administrator, or if you login with a username that does not
have any administrator privileges, then when you configure Click to Dial
you will encounter the following error:

Unable to get profile due to network or certificate
issue

No workaround is available for an account without administrator
privileges. The user must have administrator privileges in Vista in order
for Click-to-Dial to work. For an account with administrator privileges: In
Windows Explorer, go to the WebEx Connect client application (for
example, C:\Program Files\WebEx\Connect), right-click onit,and choose
Run as administrator. This launches the Connect client with the correct
privileges to modify the registry for click-to-dial to work in Windows
Vista.

The following limitations apply to deployment of Cisco IP Phone SPA525G
phones in Wireless-G mode using Cisco Configuration Assistant:

- Multicast Music on Hold (MoH) for internal calls (IP Phone-to-IP Phone) is
not supported for this solution and must be disabled using CCA.

When you disable MoH for internal calls, Music on Hold for the external
MoH port on the UC500 is also disabled.
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To disable Music on Hold for internal calls using CCA:
1. Launch CCA and navigate to the Music on Hold configuration settings.

2. Uncheck these options: Enable external music on hold port and
Enable music on hold for internal calls.

- Unicast paging groups are required with Cisco SPA525G/G2 wireless
phones. A maximum of ten phones can be in a unicast paging group.

- The SPA525G phone is not designed to comply with Japanese Wi-Fi
requirements. Specifically it does not support channel 14.
The AP521G-PK9 SKU also does not support channel 14.

For detailed information on supported reference designs, limitations and
caveats for deployment of Cisco IP Phone SPA525G phones, see the
Cisco SPA525G Wireless Deployment Guide for Cisco SBCS, available
at www.cisco.com/go/sbcs-docs.

In the Port Settings window, you must apply a change to speed settings
before you can change a duplex setting. After you configure a speed setting,
click Apply, and then configure a duplex setting.

You must use the Smartports feature to apply an Access Point role to
Catalyst Express switch ports, ESW500 Series switch ports, and Cisco
Unified Communications 500 Series ports that are connected to wireless
LAN controllers, autonomous access points, or lightweight access points.

When you create or modify a Service Set Identifier (SSID) for a wireless LAN
controller:

- Assign the native VLAN to it only if the native VLAN is VLAN 1.

- Ensure that the IP address of the management and AP manager
interfaces of the wireless LAN controller belong to the native VLAN.

When you create or modify an SSID for an autonomous access point:
- Check Native VLAN only if the assigned VLAN is the native VLAN.

- Ensure that the IP address of the autonomous access point belongs to the
native VLAN.

Concurrent use of T.37 Fax to Mail services and SNR is not supported.

An SNR user cannot be provisioned as a member of a hunt group, nor can
SNR be provisioned for a user that is an existing member of a hunt group.
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Downloading a Software Pack from https://supportforums.cisco.com/docs/
DOC-9829 using Microsoft Internet Explorer may cause truncation error.
The download file name is truncated by character. This issue is not
encountered when downloaded from the CCO location. This issue has not
been observed when downloaded from Firefox or Chrome.

Notes

The following notes apply to Cisco Configuration Assistant 2.0 and later:

When you start Cisco Configuration Assistant, Java determines whether the
resources it needs are available.

If they are not, Java displays the message Could not create Java
Virtual machine, and the session ends. To overcome this problem, open
the file C:\Program Files\Cisco Systems\CiscoSMB\Cisco Configuration
Assistant\startup\startup.properties (the default installation path), and
modify this entry:

JVM_MAXIMUM HEAP=1024m
Replace 1024m with 512m.
This problem can occur on PCs with lesser specifications.

If the Cisco Configuration Assistant InstallShield Wizard fails to start, it is
likely there is a problem with the temporary folder location defined through
the environment variables TMP and TEMP. Assign a correcttemporary folder
location to fix this problem.

Resolving Cisco Model 79xx Phone Upgrade Issues

After installing a UC500 software pack that contains version 8.5(3) phone firmware
for Cisco Model 79xx IP phones, Model 79xx phones being upgraded from
firmware versions prior to 8.5(2) may not register, or may register but still be
running an older version of the phone firmware. When the phone attempts to
upgrade to 8.5(3), you may see the message “Auth Fail” displayed on the phone.

This is due to a known issue with Model 79xx IP phones (the issue is documented
in the Cisco Unified IP Phone Release Notes for Firmware Release 8.5(3) (SCCP
and SIP (www.cisco.com/en/US/docs/voice_ip_comm/cuipph/firmware/8_5_3/
english/release/notes/7900_853.html#wp57602).
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STEP 1

STEP 2

STEP 3

STEP 4

STEP 5

STEP 6

STEP 7

For all SCCP firmware upgrades from firmware release versions earlier than 8.3(3)
to version 8.5(3) or later, you must first upgrade your firmware to version 8.5(2).
Once you have upgraded to version 8.5(2), you can upgrade your IP Phone to
version 8.5(3) or later. The problem affects these CCA-supported phone models:

Model 7975, 7970, and 7971
Models 7945 and 7965
Models 7942 and 7962
Models 7941 and 7961
Models 7906 and 7911
Model 7931

Perform the procedure in this section to correct the problem by upgrading the
phones to an intermediate load before upgrading them to version 8.5(3) firmware.

Before You Begin—Download the 8.5(2) Phone Firmware

Download the 8.5(2) phone firmware .zip file for each model phone that must be
upgraded. This is the intermediate load that will be used.

IMPORTANT You must download the 8.5(2) version of the phone firmware. The
8.5.2SR1 load cannot be used for this purpose.

To locate the 8.5(2) version of the SCCP (Skinny Client Control Protocol) version of
the firmware for the desired phone models, follow these steps.

Log in to Cisco.com (you must have a Cisco.com login to download phone
firmware).

Open a Web browser and go to www.cisco.com/go/software.

On the Download Software page, choose Voice and Unified Communications >
IP Telephony > IP Phones > Cisco Unified IP Phone 7900 Series > Cisco
Unified IP Phone <79xx>.

Click the Skinny Client Control Protocol (SCCP) Software link.
In the Search Release field, enter 8.5(2) and click Go.
Click the link to the 8.5(2) software.

Download the .zip file for the selected model. For example, the filename for Model
7975 phones is cmterm-7975-sccp.8-5-2. zip.
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STEP 8

STEP 1

STEP 2

STEP 3

STEP 4

Repeat these steps to download 8.5(2) firmware for each of the phone models to
be upgraded.

Upgrading the Phone Firmware

Perform these steps to upgrade the affected Model 79xx phones with version
8.5(2) firmware as an intermediate step and then upgrade them to version 8.5(3)
firmware.

IMPORTANT The embedded TFTP server in CCA is used for drag-and-drop file
uploads. Before performing the upgrade, disable any third-party TFTP services
running on your PC and check the firewall and network security settings on your
PC to make sure that TFTP packets can be transmitted between your PC and the
UC500.

Launch CCA and open the Topology view.

Drag and drop the .zip file with the 8.5(2) phone firmware onto the UC500 icon in
the Topology view.

Do not change the .zip file name or unzip the file.

In the File Upload dialog, click Upload.

CCA extracts the files from the .zip archive and copies them to a temporary
directory on the UC500 flash. If there are any TFTP and load configurations for
8.5(3), these are replaced with the intermediate 8.5(2) load and files.

The Phone Firmware Update dialog shows the progress of the upload. Once the
files are copied to the flash, CCA displays the following message:

“Disconnect all Cisco Model <Model Number> IP phones, and then reconnect
them. Wait until the phone firmware upgrade completes, then click OK to
continue.”

Disconnect and then immediately reconnect the indicated phones. Wait for the
upgrade to complete on all the indicated phones.

IMPORTANT Do not click OK until all of the affected phones have upgraded their
firmware and re-registered. The upgrade takes at least 10 - 11 minutes and the
phones will restart. To verify that the interim load has been installed, press the
settings button on the phone and navigate to Settings > Status > Firmware
Versions > Load File. The interim load filename is SCCP45.8-5.2S.
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After the interim upgrade completes, CCA removes the interim 8.5(2) TFTP and
load commands, replaces them with the 8.5(3) TFTP and load commands, and
then issues a reload/reset command to the phones to load the 8.5(3) firmware.
Once the final reload and reset completes, the phones will be upgraded to the
8.5(3) firmware and re-register with the UC500.

STEP 5 Repeat these steps for each different phone firmware .zip file.

Cisco SBCS Features Supported Within CCA

The Cisco Smart Business Communications System Feature Reference Guide
provides guidance to partners on the features that can be configured using the
latest releases of CCA. The information is categorized by Voice, Switching,
Wireless, and Security.

This guide is available on the Resources tab on the main Cisco Smart Business
Communications product page (www.cisco.com/go/sbcs). From within CCA you
can choose Partner Connection > SBCS Feature Guide to access the guide.

Open Caveats

This section describes the open caveats that could create unexpected activity in
this software release.

Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number Description

CSCtn48997 The voice VLAN static route is missing when changing the voice and data VLAN from
the default IP.

Symptom This will happen when an SR520 and UC are not initially configured by the
Telephony Setup Wizard. It will not happen if the Telephony Setup Wizard was used to
configure an SR520 and UC.

Workaround Manually add static route in SR520-t1 to a newly created Voice VLAN
IP network.

28 Release Notes for Cisco Configuration Assistant 3.2


http://www.cisco.com/go/sbcs

Release Notes

Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number Description

CSCtl06532 SIP Trunk: Add configuration to remove second ¢ header in SDP.
Symptom Multiple ¢ headers are sent in the SDP. This causes issues when the
upstream NAT device sees only NATs on the ¢ header. Service Provider SIP proxy
adheres to RFC3264 and only looks at media level c= line and ignores session level c=
line.
Workaround None.

CSCtk96606 Icon for the 6945 IP Phone is incorrect in the Topology View.
Symptom The icon used for the 6945 IP phone is incorrect in the Topology View.
Workaround None. The Model 6945 IP phone is not supported by CCA. CCA
discovers the phone and displays it in the Topology view, but since itis not a
supported phone, CCA displays the default phone icon in the Topology view.

CSCtk76997 Expansion modules added via the Telephony Setup Wizard do not appear on the Users
and Phones screen.
Symptom The Users and Phones screen does not show phone expansion modules
that were added via the Telephony Setup Wizard.
Workaround None.

CSCtj56444 Program Compatibility Assistant popup appears when installing the CCA on a PC
running Windows 7.
Symptom Program Compatibility Assistant appears after a full CCA installation,
warning the user that the installation might not have installed correctly.
Workaround Choose the option "This program installed correctly" in the Program
Compatibility Assistant popup dialog.

CSCti43610 SR520 crashes after applying IPS configuration.

Symptom SR520 crashes after configuring IPS with CCA when the
sigvb-SDM-S414.zip signature file is used.

Workaround Use a different IPS signature file.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number Description

CSCti25821 Anyconnect 2.5 does not work with the SR520-T1 SSL VPN sever.

Symptom An SR520-T1 running SSL-VPN sever with version 2.5 of the Anyconnect
client (anyconnect-win-2.5.02 17-k9.pkg) cannot connect to the SSL VPN server due to a
certification error.

Workaround Use version 2.3 of the Anyconnect client (anyconnect-win-2.3.0254-
k9.pkg).

CSCtgb50723 SIP Trunk: Support individual DIDs for diversion header on SIP trunks.

Symptom When the UC500 is using SIP trunks for PSTN access and there are hairpin
calls (from the PSTN to the UC500, and then back out to the PSTN), the diversion header
for forwarded calls on SIP INVITE from the UC500 only has the main number DID.

Workaround None.

CSCta94933 Need to be able to use a loopback IP address as a source IP for XO SIP Trunk.

Symptom XO SIP trunk requires the ability to specify a source IP address for SIP and
RTP packets on the UC500.

Workaround XO SIP trunk provider will provision the circuit with a source IP
address to be the same as the internet IP address on the XO circuit.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number

Description

CSCsz29268

WebEx PhoneConnect: Locale change is not picked up unless the administrator enters
the WebEx PhoneConnect application screen.

Symptom The user changes the CME locale after having configured WebEx
PhoneConnect and the phone does not pick up the new language. This occurs only if the
WebEx PhoneConnect configuration windows in CCA are not accessed after the CME
locale is changed.

Workaround Set the CME locale before configuring the WebEx PhoneConnect
application.

Alternatively, if after setting up the PhoneConnect users and changing the CME locale,
the WebEx PhoneConnect screens on user phones do not have the new language, do
the following:

1. Exit any WebEx PhoneConnect configuration windows that may be open in CCA.
Close any open WebEx PhoneConnect application screens on IP phones.

2. In CCA, go to Applications > Smart Business Applications, select the WebEx
PhoneConnect application, click Setup Options and log into the WebEx
PhoneConnect application. This will open the PhoneConnect Application Main
window and send the CME locale to the PhoneConnect application.

3. Click OK or Apply.

If, after performing the actions listed above, the new language does not appear on the
phones do the following:

1. Exit all WebEx PhoneConnect configuration windows and IP phone screens.
2. Restart CUE from the Maintenance window (Maintenance > Restart/Reset).

3. Wait for the CUE restart to finish.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number

Description

CSCsx86872

A DID does not register when Service Provider SIP trunk configuration is loaded from
different PCs.

Symptom Some Day2 additions or modifications under Telephony are misconfigured
for a custom SIP Provider. For example, an added DID may not register correctly. The
custom SIP Provider name is shown in the SIP Provider dropdown list but no Template
information is displayed. The CCA Application log contains this error: ++: ERROR: :
SIPData: SIP Provider read from device is not supported by any template: <PROVIDER
NAME>

Workaround To get around this problem, use only the original CCA installation to
make Telephony related modifications OR add the custom SIP Provider template
(.xml) to all CCA installations which may configure the same UC500.

CSCsx62251

WebEx PhoneConnect: Join before meeting start option is only available to the host, not
the attendee.

Symptom When scheduling a non-audio WebEx Meeting Pro with an option to let
attendees join x minutes before start time, alerts with the Call button x minutes before the
start time are only sent to the host. Alerts for the attendees do not display a Call button
until the meeting start time.

Workaround None.

CSCsx20742

WebEx PhoneConnect: Intermittently phones cannot dial into meeting.

Symptom Intermittently, phone users are unable to have PhoneConnect auto-dial into
the meeting. After the Call button is pressed, the phone remains on the dialing screen,
and no audio is heard.

Workaround To recover, the phone the user must manually end the call. The phone
user can then press the Services button, select WebEx Meetings > Today, click
Details, then either click Call to retry the auto-dial, or manually dial in to the meeting
using the information from the meeting details page.

CSCsx10880

WebEx PhoneConnect: Alternate host and host cannot both join meeting.

Symptom If a user creates a meeting with an alternate host, the host and the alternate
host cannot both join the meeting. The first host to join the meeting is granted host
privileges and the other host cannot join the meeting.

Workaround None.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number Description

CSCtr20290 Telephony Setup Wizard: Issues in uploading a .wav file in prompt management.
Symptom
1. When uploading a .wav file of 1IMB or less, and not recorded in G.7 11 u-law, an error
message is displayed, but the length of the wave file is retained and shown on the
screen.

2. When a .wav file, of IMB or more is uploaded, it is not accepted. however no error
message is displayed

3. When a .wav file, which is not recorded in g.711 u-law and more than 1MB, is uploaded
a no error message is displayed.

Workaround None.

CSCtr19665 Enable-Disable Voice mail resets the Dial-by Name configuration.
Symptom Configure > Telephony > Call Handling > Dial-by Name configuration resets
to none, and does not inform the user.
Workaround None.

CSCtr14585 Smart ports: Maximum hosts field issue in Nikola Switch port setup.
Symptom Selected port role is configured on the port.
Workaround Enter a value 1 - 10 in the Maximum Hosts field, or leave the default
value if present.

CSCtr11628 Users list under Hunt Group and Incoming Dial Plan does not show completely.
Symptom Creating Hunt Group and Call Blast Group through Telephone Setup Wizard
allows the option to forward the calls to some destination (either Voice mail or other
Extension), and the users and users list is not fully displayed when forwarded to another
user. Not able to select the user, other than the list showing on the screen.
Workaround Do not configure more than 34 users. Configure more users in expert
mode.

CSCtr06309 Call accounting to FTP server via CCA fails.

Symptom Enabling call accounting to FTP server fails.

Workaround Manually backup from flash.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number

Description

CSCtq78188

Changing the installed language does not modify the configuration under CCN trigger
SIP.

Symptom Changing the installed language to another language (e.g..Spanish to Dutch)
does not modify the configuration under ccn trigger sip; thus calling to the Dutch VM pilot
number does not play any voice, and the call disconnects after sometime.

Workaround Before changing the installed language perform a factory reset, then
proceed with the locale upgrade or software upgrade.

CSCtg67250

Last 4 buttons of 7931 phone becomes inactive after applying custom template.

Symptom The last 4 buttons, which are used for Messages, Directories, Head set
Menu, become inactive when applying a custom template or template 17 These buttons
are assessable only if template 15 is assigned to the phone.

Workaround None.

CSCtq54784

Deleted user still has userid and extension information in mailbox.

Symptom After deleting a user with a mailbox at Telephony > Users and Extensions >
User and Phone > User Extensions Ul, incomplete mailbox information may appear under
Telephony > Users and Extensions > Voicemail > Mailboxes Ul (i.e., a userld without the

first name and last name).

Workaround Click refresh in the User and Phones window.

CSCtq55689

Ports > Switch Port Settings > Runtime Status > Device always Unknown.
Symptom Connected device type is not shown in Runtime Status of Switch Port.

Workaround To view devices connected to the switch, click the "Topology Options"
button in Topology View, then select "Link Interface ID" in the "Show Information" tab.

CSCtq04998

Smart port: Modified port role shows empty when multiple modification is selected.
Symptom This happens only when multiple ports are selected to modify.

Workaround Select single port then click Modify to see the smartport role that is
configured on the port.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number Description

CSCt004948 Not able to select the users in the call routing section of the Telephony Setup Wizard if
the number of users is greater than 35.

Symptom Users are not listed in Incoming Call Handling section of the Telephony
Setup Wizard if there are more than 35 users.

Workaround Press the down arrows by assuming the count.

CSCtn55711 Changing the subnet of third octet will not change the DHCP range of the IP addresses.

Symptom Changing the subnet mask of third octet will not change the DHCP range of
IP addresses.

Workaround There is no workaround in TSW. Changes can be made in expert
mode.

CSCtn56620 VM personalized settings are not completely restored.

Symptom User is prompted for the Voice Mail password and then prompted again to
personalize the Voice Mail settings.

Workaround Add Voice Mail and personalize settings again after password
prompt.

CSCtn39148 Telephony Setup Wizard: Deleting the last digit in the extension field retains the original
value.

Symptom While running Telephony Setup Wizard, and attempting to delete the last
number on FXS, the Voice Mail number filed does not get deleted and returns to the
original pre configured value.

Workaround No workaround in Telephone Setup Wizard. Make the changes in
expert mode.

CSCtn38381 Telephony Setup Wizard: Cannot remove a pre-populated userid.
Symptom Not able to change the Userid.

Workaround None.

CSCtn14032 System uptime for AP54 1Ns always shows zero.
Symptom System uptime in Inventory dialog is always shown as zero.

Workaround No workaround in CCA. Launch Configuration utility of device and
check system uptime.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number Description

CSCtn10171 Extra UC icon on topology after Telephony Setup Wizard.
Symptom Extra UC500 icons will sometimes show up in topology.
Workaround Click on the "Refresh" toolbar icon and the second UC500 no longer
appears.

CSCtl45859 Using CCA to reset to factory default does not restore default Voice Mail language to US
English.
Symptom After resetting to factory default, the VM language is not restored to US
English.
Workaround Reinstall software pack with format flash and then apply the factory
default.

CSCtj67013 A user profile in use should not be deleted.
Symptom The user profile which is in use can be deleted. If deleted the user can be
logged out of the phone and could not login again.
Workaround Login a phone using a user profile. Then delete the user profile from
CCA, EM window.

CSCtr03765 Call Blast Group does not support Dynamic Login/Logout; as Call Blast Group did not
support dynamic login/logout through softkeys.
Symptom The hlog button does not log out of the Blast Group when Blast Group is
called. The hlog button logs out of the Hunt Group (sequential), and the phone will not
ring.
Workaround None.

CSCtx01717 Smart port for an access point failed on the UC520.
Symptom Smart Port for access point failed on the UC520.
Workaround If configuration fails first time relaunch the dialog and reapply the
value.
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number Description

CSCtu42616 PRI ISDN map is automatically restored on reconfigure of PRI.
Symptom The "Map All Outgoing Calls to Unknown Numbering Type and Plan" is
checked, and ISDN mapping present on controller, when it may not be expected.
Workaround To avoid the condition, Apply uncheck of "Map All Outgoing Calls to
Unknown Numbering Type and Plan” prior to any Time Slot changes or Channel
Signaling changes.
After the condition has occurred, uncheck of "Map All Outgoing Calls to Unknown
Numbering Type and Plan" and Apply.

CSCtu26773 ST: Registrar Server Expiry may not be applied without the Registrar Server
Symptom Registrar Server Expiry value not applied.
Workaround Do not configure value for Registrar Server Expiry if Register Server
is not also configured.

CSCtu02294 Channel signaling modified does not push the config to the router.
Symptom Modified Channel Signaling not applied.
Workaround In case that Channel Signaling must be modified after first
configuration and initialization of T1 card, select "Refresh" button before making the
modification. Alternatively, change to "None" prior to changing to new type.

CSCtw60568 | CCA hangs with white screen if an external http server is running
Symptom CCA hangs with white screen if an external http server is running. This is
happening when CCA and external HTTP server is running on a same PC for a long time
Workaround
1. Relaunch CCA to continue normally
2. Do not run external HTTP server when CCA is also running

CSCtw66086 | MSM: Firewall/NAT and MSM dependency issue

Symptom Enabling firewall after configuring Multisite does not generate proper NAT
mappings.

Workaround Configure Firewall or NAT before configuring Multisite
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Table 7 Open Caveats in Cisco Configuration Assistant 3.2 and earlier

Ref Number Description

CSCtx56559 Unable to configure T1 ports with analog signaling after Multisite Confguration on the
UC520.
Symptom T1 ports cannot be configured with analog signalling type, such as FXO/
E&M, after configuring Multisite feature on the UC520.
Workaround Perform a factory reset of the device, then configure the T1 ports
before configuring multisite.

CSCts31263 The alternate locale pack selected, along with Software Upgrade (without factory

default), fails to install the alternate language prompts in the CUE.

Symptom When an alternate locale pack is selected along with SW Upgrade (without
factory default) it fails to install the alternate language prompts in the CUE.

Symptom Upgrade the locale pack using 'Install locale pack'’ option.

Resolved Caveats in CCA 3.2

This section describes the resolved caveats for the current release.

Table 8 Resolved Caveats in Cisco Configuration Assistant 3.2

Ref Number Description
CSCtcb56855 grande: The licence support for UC560 shows discrepancy across different screens in
ul.

CSCth93111 System: Unclear how to remove Telephony System Message.

CSCti96386 Local Directory Feature.

CSCtq12185 CCA should not allow user to enter same network address for 2 DHCP pools.

CSCtg71662 Exit Wizard button at the end of the Telephony Setup Wizard is not working after chang-
ing the data VLAN IP.

CSCtq97238 CCA window hangs when the number of users exceeds the maximum limit.

CSCtq98625 CCA: Multisite - Users experience no audio in multisite config when transferring
between sites. After h245 timers expire, the call drops on its own.
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Table 8 Resolved Caveats in Cisco Configuration Assistant 3.2

Ref Number Description

CSCtr18050 Web access for 7900 series phone is still present, even if checkbox, listed under the
feature tab in Users and Phones, is unchecked.

CSCtr47098 All phones failed to register when VLAN100 IP address changed via the CCA.

CSCtr48459 Enabling Multi-party conferencing, applying the configuration, and then changing the
mode/codecs results in changing the slider to always move to meetme only.

CSCtr51339 Invalid error message is shown in the event notification window after adding the Nikola
switch to the community with invalid credentials.

CSCtr75468 Hunt Group: Online help needs to be updated. Statement, "and can contain up to 32
members" needs to be updated to "and can contain up to 20 members."

CSCtr88721 CCA: When configuring static NAT, you can not configure mapping for both UDP and
TCP on the same port.

CSCtr95307 CCA 3.1: Cannot create blast group with CFNA to mailbox.

CSCtr96010 CCA: Upgrade to SWP 8.2.0 fails. In most of the cases, the flash is either empty or not all
files are on it.

CSCts05214 CCA should validate the IP address of UC 560 gigabitethernt0/0 interface.

CSCts05773 UC540: Caller ID not showing up on the phone for incoming calls from FXO ports.

CSCts08304 User buttons configured with intercom become listed under other phones when trying
to configure intercom in the third phone.

CSCts11018 CCA 3.1 call back rules only work when combined with CCA Incoming Dial Plans for
Direct Dialing but not for FXO.

CSCts18735 CCA: Multisite Manager auto configures remote Data VLAN IP Address.

CSCts19149 CCA: When configuring Multisite, CCA configures an EEM script to ping across the
tunnel.

CSCts27247 After configuring SSL VPN on the SR520, data is missing in the CLI.

CSCts28637 CO line drop-down list always showing already configured lines.

CSCts30360 After IMAP is enabled, "groupname IMAPgrp privilege vm-imap" is missing.

CSCts69886 CCA: Drag and drop with SPA525G phone firmware not working.
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Table 8 Resolved Caveats in Cisco Configuration Assistant 3.2

Ref Number Description

CSCts72166 Issue while configuring more than 24 speed dials in CCA. Under the Speed Dial tab, if
speed dials are configured with more than 24 buttons then the CLlIs are not pushed to
the router.

CSCts96850 CCA should configure paging group with multicast by default.

CSCts96869 CCA should handle dial-peer for a newly added VIC-FXO card. When a new VIC-FXO
card is added to the existing UC500, there is no way to configure dial-peer for the FXO
ports; you must manually configure dial-peer.

CSCtt05009 The Germany dial plan is incorrect, as it does not allow long distance calls.

CSCtt33563 VPN Server page sticks indefinitely in a particular scenario -where SSL VPN is
configured on top of EZVPN.

CSCtt43014 Outgoing Dial Plan does not reflect a change of default access code to custom value via
the Telephony Setup Wizard. - In Telephony Setup Wizard, changing the default access
code value from 9 to some other custom value (such as 7), does not reflect the access
code change in the Outgoing Dial Plan window.

CSCtu34208 CCA: Add ability to configure DNS Servers in SSL VPN.

CSCtu77030 CCA: Multisite doesn't remove transcoders when deleting configuration.

- When configuring Multisite in CCA, using g729 codec, CCA will also configure
transcoders if they are not currently present from SIP Trunk.

- When deleting the Multisite configuration in CCA, it will remove everything, except the
transcoders.

CSCtw95724 | CCA: NullPointerException seen when loading Phones and Users

CSCtx04318 CCA: Cannot change vilan 1 IP address after enabling T.37 fax to email.

CSCtx19983 CCA: Not allow prompt option in AA to go to BACD.

CSCitx25547 Dial-plan hangs when parsing duplicate dial-peer.

CSCtx33112 UC540W - CCA hangs when trying to launch the AA page
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Cisco Unified Communications 500 Series Configuration
Support Policy

Information about Cisco Unified Communications 500 Series Configuration
Support Policy is available at:

https://supportforums.cisco.com/docs/DOC-14855

NOTE: Requires partner login to access.

Cisco Small Business Support Community

The Cisco Small Business Support Community site provides resources to assist
VARSs and Partners with design, implementation, and maintenance for Cisco SBCS
platforms. To access the Cisco Small Business Support Community, point your
web browser to the following URL:

www.cisco.com/go/smallbizsupport

Documentation for Cisco Configuration Assistant

The following documentation is provided for Cisco Configuration Assistant:

Cisco Configuration Assistant Smart Business Communications System
Administrator Guide, a comprehensive, end-to-end guide that covers all
features and configuration tasks that can be performed using CCA.

The administration guide is also available in PDF format through the online
help system in CCA.

Online help. To access online help, click the Help button provided in CCA
windows and dialogs, choose Help > Contents from the menubar, or press
F1 to display Help for the active window.

These release notes.

To access documentation for Cisco Configuration Assistant on Cisco.com, visit the
following URL:

www.cisco.com/en/US/products/ps7287/tsd_products_support_series_home.html
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Where to Go From Here

Cisco provides a wide range of resources to help you and your customer obtain
the full benefits of Cisco Configuration Assistant.

Cisco Configuration Assistant

Cisco Configuration Assistant www.cisco.com/go/configassist

Product Page

Cisco Configuration Assistant Technical www.cisco.com/en/US/products/ps7287/
Documentation tsd_products_support_series_home.html

Cisco Small Business

Cisco Partner Central for Small Business www.cisco.com/web/partners/sell/smb
(Partner Login Required)

Cisco Small Business Home www.cisco.com/smb

Cisco Small Business Support

Cisco Small Business Support Community | www.cisco.com/go/smallbizsupport

Cisco Small Business Support and www.cisco.com/go/smallbizhelp
Resources
Phone Support Contacts www.cisco.com/en/US/support/

tsd_cisco_small_business
_support_center_contacts.html

Cisco Small Business Firmware Downloads | www.cisco.com/cisco/software/navigator.html

Cisco Smart Business Communications System and Components

Cisco UC500 software packages and www.cisco.com/go/uc500swpk
localization files
(Cisco.com Login Required)

Cisco Smart Business Communications www.cisco.com/go/sbcsresources
System

Cisco Unified Communications 500 Series | www.cisco.com/go/uc500resources

Cisco Unified Communications 500 Series | www.cisco.com/en/US/partner/prod/collateral/
Configuration Support Policy netmgtsw/ps7256/ps7287/
cisco_cca_cli_support_policy.pdf

(This link requires CCO login)

Cisco SPA500 Series IP Phone www.cisco.com/go/spa500phones

Cisco SPA300 Series IP Phones www.cisco.com/en/US/products/ps10998/
tsd_products_support_series_home.html

Cisco Unified IP Phones 7900 Series www.cisco.com/en/US/products/hw/phones/
ps379/
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Cisco AP541N Access Point

www.cisco.com/go/ap500resources

Cisco SA500 Security Appliance

www.cisco.com/go/sab500resources

Cisco ESW500 Series Switches

www.cisco.com/go/esw500resources

Cisco Small Business 300 Series Managed
Switches

www.cisco.com/go/300switches

Cisco 200 Series Smart Switches

www.cisco.com/go/200switches

Cisco PVC2300 (Audio/PoE) and
WVC2300 (Audio/Wireless-G) Business
Internet Video Cameras

www.cisco.com/go/smallbizcameras

Cisco Secure Router SR500 Series

www.cisco.com/go/sr500

License Notices

Open Source License Notices

www.cisco.com/go/osin

The Open Source Llcense Notice for CCA 3.2 is
available on the CCA software download page on
Cisco.com.

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any
examples, command display output, and figures included in the document are shown for illustrative purposes
only. Any use of actual IP addresses in illustrative content is unintentional and coincidental.

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and other
countries. A listing of Cisco's trademarks can be found at www.cisco.com/go/trademarks. Third party
trademarks mentioned are the property of their respective owners. The use of the word partner does not
imply a partnership relationship between Cisco and any other company. (1005R)

© 2012 Cisco Systems, Inc. All rights reserved.

Document Number: OL-25658-01
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